CHEM 23201
Assignment #2
General Information & Presentation Abstract
Due: Next meeting

Research Strategy (9 pts)

1. Complete steps 1-3 of the Research Strategy

Secondary Literature – Encyclopedias, Handbooks, & Dictionaries (4 pts)

2. Find a description or information about your compound in one print (1) secondary literature source.
   The sources can be general (e.g., World Book Encyclopedia, McGraw-Hill Encyclopedia of Science & Technology, etc.) or subject specific (e.g., see attached list).
   a. Copy the page about your compound. If there is more than one page then copy the first page.
   b. Add the citation to your RefWorks database.

Finding Information (the free stuff) via the Web (13 pts)
(Use a minimum of two concepts when searching)

3. Using Google (www.google.com) find one (1) web page providing information on your compound.
   a. Print the google results page that gave you this one (1) document and highlight the entry and highlight your search strategy.
   b. Add the citation to your RefWorks database. (see instructions)

4. Using Google Scholar (scholar.google.com) find one (1) article about your compound.
   a. Print the google scholar results page that gave you this one (1) article and highlight the entry and highlight your search strategy.
   b. Add the citation to your RefWorks database. (see instructions)

5. Using Google Book (book.google.com) find one (1) book that has at least a section about your compound.
   a. Print the google book results page that gave you this one (1) book and highlight the entry and highlight your search strategy.
   b. What is the closest library to have this book according to WorldCat? (Click on the link Find in a library in the Get this book in print section.)
   c. Add the citation to your RefWorks database. (In WorldCat click the Cite/Export link near the top of the page.)

6. You now have 4 articles from questions 2-5. Which one do you trust the most and why? Which one do you trust the least and why?
Using interlibrary loan (ILL) (5 pts)
You can borrow anything ND doesn’t own (book, article, patent, CD, DVD) from another library.

7. Set-up an interlibrary loan (ILL) account.
   a. Go to http://chemistry.library.nd.edu/ and in the Quick Links section click on the Interlibrary loan link.
   b. Supply your NETid and password then click the Logon to ILL button.
   c. At the top left of the page click the Edit User Information button.
   d. Fill out the form.
   e. Then click the Submit Information button.

8. Request an item via ILL that Notre Dame does not own or does not have access to.
The item can be for this class or for another class or just because you are interested.
   a. Click Outstanding Requests link, print that page.

Presentation Abstract – First Draft (9 pts)

9a. Name the compound that will be the subject of your presentation.

   Use one or two sentences to answer questions b. to f. (You may not have anything to write for the last two questions – at this point in your research that is fine.)

   DO NOT COMBINE your answers into a paragraph.

9b. Motivation: What is the general topic you are investigating and why is it important? Start with the big picture then mention how your compound fits into the big picture.

9c. Problem Statement: What is/are the specific question(s) you are addressing with your research? This is the usually the same as the statement in step 1 of the research strategy.

9d. Approach: How did you go about solving or making progress with your research?

9e. Results: What did you find out?

9f. Conclusions: What are the implications of your answer?
Dictionaries, Encyclopedias, & Handbooks
A representative sample

Chemistry Physics Library

Concise encyclopedia of biochemistry.
CRC handbook of chemistry and physics.
Dictionary of inorganic compounds.
Dictionary of natural products.
Dictionary of organic compounds.
Dictionary of organometallic compounds.
Encyclopedia of inorganic chemistry.
Encyclopedia of reagents for organic synthesis.
Kirk-Othmer concise encyclopedia of chemical technology.
Lange’s handbook of chemistry.
Macmillan encyclopedia of chemistry.
McGraw-Hill encyclopedia of chemistry.
The Merck index: an encyclopedia of chemicals, drugs, and biologicals.

Engineering Library

Kirk-Othmer concise encyclopedia of chemical technology.

Hesburgh Library

Encyclopedia of molecular biology.
Oxford dictionary of biochemistry and molecular biology.
Wiley encyclopedia of molecular medicine.
How to set up a RefWorks account

Registration is required to use this service. You must do the following steps from an on-campus computer. Then you can use any computer anywhere.

1. Go to chemistry.library.nd.edu
2. Click on RefWorks link in the Quicklinks box
3. Click on Sign up for a New Account in the gray box on the left side of the window.
4. Enter Account Information.
   a. Use your NetID for the Login Name
   b. Don’t use your NetID password for the Password
5. Enter User Information
6. Click Create Account.

Adding Citations Manually into RefWorks

In RefWorks

1. Login to your RefWorks database if you have not already done so.
2. From the References drop-down menu select Add New.
3. From the Fields used by: select Accounts of Chemical Research (updated).
4. From the Reference Type drop-down menu select the appropriate publication type based on decision tree.
5. Enter the information from your reference into the appropriate fields.
6. From the Add to folder drop-down menu select the desired folder.
7. Click on Save Reference if adding one reference, or click on Save & Add New if adding more than one.

Use this when you don’t want to import/export references; when you have results from a search of the USPTO or esp@cenet patent databases; or results from an NCBI search.
Moving Citations from the Notre Dame Library Catalog into RefWorks

In RefWorks

1. From the **Search** drop-down menu select **Online Catalog or Database**
2. Select **Notre Dame Library Catalog** from the **Search** drop-down menu.
3. Enter your search in the **Advanced Search for:** section.
4. Click the **Search** button.
5. Select the title(s) you want added to your bibliography by checking the box to the left of the **Ref ID #**.
6. Click the **Import** button.
7. Click **OK** if you are sure you want to import.

Most likely you will need to edit the citation to change the Ref Type, add or correction information.

8. Look at the records in the **Last Imported** folder
9. Click the **Edit** icon on the right side of the grey bar above the citation to be edited. The edit icon is the pencil & paper symbol -
10. Verify that **Accounts of Chemical Research (updated)** is the selection in the **View fields used by:** drop-down menu.
11. Consult the Decision Tree to determine the appropriate Reference Type to select.
12. Add / Correction information in the record.
13. Click the **Save Reference** button.
Moving Citations from Google.com into RefWorks using RefGrab-It

One Time Set Up Instructions for your computer

1. Login to your RefWorks account.
2. Select RefGrab-It from the Tools drop-down menu.
3. Follow instructions for your operating system and browser preference.

At a web page via Google.com

1. When you are on a web page you want to grab information from, just click on the RefGrab-It button in your toolbar or bookmark list.
2. Click the red icon 📄 to import to RefWorks.

In RefWorks

1. If you are not logged in to your account, you will be prompted to log-in. Otherwise, your records will appear in the Last Imported folder.
2. Consult the Decision Tree to determine the appropriate Ref Type to select and to see how to format the date correctly.
Moving Citations from Google Book into RefWorks

In Google Book

2. Click on the Title link for the desired item.
3. Click on the Find in a library link – this is on the left side of the window.
   Sometimes the Find in a library link is within the Get this book in print link. (this sends you to a different website – http://www.worldcat.org)
3a. If the “Find in a library” link is not there then copy the title or better yet copy the ISBN and search for the item at the worldcat link above.
4. Click on the Cite/Export link. (above the title to the right -
   
   ![Cite/Export]

5. Select Export to RefWorks

In RefWorks

1. Login to your RefWorks database if you have not already done so.
2. Your citation will automatically be imported into the Last Imported Folder.
3. Click on View Last Imported Folder button
4. Click the Edit link – in the upper right part of the window
5. Make sure the View fields used by: is set to Accounts of Chemical Research (updated).
6. Make sure the Ref Type: is something that fits the book. This means about 70% of the time it should be Book, Whole. Other options are Book, Edited; Book, Section; or maybe Dissertation/Thesis. Consult the Decision Tree to determine the appropriate Ref Type to select.
Moving Citations from Google Scholar into RefWorks

One Time Set Up Instructions for your computer

2. Click on the down triangle in the upper right corner of the window.
3. Select Settings
4. Scroll down to the Bibliography Manager section.
5. Click in the radio button next to Show links to import citations into.
6. Select RefWorks from the drop-down menu.
7. Click on Save.

In Google Scholar

1. Conduct your search in Google Scholar.
2. Click on Import into RefWorks link associated with your desired record.
3. You will be prompted to login to RefWorks, if you are not already logged in.

In RefWorks

1. Your citation(s) will automatically be imported into the Last Imported Folder.
Create a Bibliography from Records in RefWorks

There are many ways to format a bibliography using RefWorks. This is a simple method of formatting a bibliography from selected records in RefWorks.

In RefWorks

1. Login to your RefWorks database if you have not already done so.
2. Click on Bibliography at the top of the screen.
3. Select Create Bibliography
4. In the References to Include From section, select a folder of references to format.
5. From the Output Style drop-down menu select Accounts of Chemical Research (updated).
   a. If you don’t see your style then click the Manage Output Styles button; click on the desired style in the list on the left then click on the green arrow point to your Favorites list.
6. Select desired format from the File Type drop-down menu.

If you choose HTML format, then the bibliography will display in a new browser window. You may then print (File -> Print) the page or save (File -> Save As) the page.

If you select any other format then you will be prompted to save the bibliography with a file name.

7. Click Create Bibliography button.

Write-N-Cite

Write-N-Cite allows you to write your paper in Microsoft Word and insert temporary citation placeholders directly from RefWorks with the click of a button.

Then, Write-N-Cite will create your in-text citations and your bibliography (based on your citation placeholders) and add it to your paper!

Write-N-Cite requires you to download a small (free) program that provides access to an abbreviated version of your RefWorks account while you are working in MS Word. You won't be able to add, edit or delete references, but you will be able to search, view and cite them.
CHEM 23201
Abstracts: Definition & Examples

An abstract is a concise summary of a presentation or written work (book, journal article, patent, etc.). Abstracts are the means of convincing busy individuals to attend your presentation or to read what you have written.

A well-written abstract usually answers the following five questions:

1. **Motivation**: Why do we care about the problem and the results? (An overview statement to help us see the big picture.) What is the general topic you are investigating and why is it important?
2. **Problem Statement**: What problem are you trying to solve? What is/are the specific question(s) you are addressing with your research?
3. **Approach**: How did you go about solving or making progress on the problem?
4. **Results**: What did you find out? What’s the answer?
5. **Conclusions**: What are the implications of your answer?

Here are four real life abstracts dissected so you can see how they answer the five questions.

Abstract 1:

1. **Motivation**: The prevalence of obesity has increased substantially since the 1980s.
2. **Problem Statement**: While immigrants are the fastest growing segment of the US population, little is known about obesity or clinician counseling about diet and exercise in this group. The goal is to determine the prevalence of obesity among immigrant subgroups and quantify the magnitude of the association with duration of US residence, and to describe reported diet and exercise counseling by birthplace, race, and ethnicity.
3. **Approach**: This was accomplished by doing a cross-sectional study using data from the 2000 National Health Interview Survey.
4. **Results**: Of 32374 respondents, 14% were immigrants. The prevalence of obesity was 16% among immigrants and 22% among US-born individuals. The age- and sex-adjusted prevalence of obesity was 8% among immigrants living in the United States for less than 1 yr, but 19% among those living in the United States for at least 15 years.
5. **Conclusions**: Early intervention with diet and physical activity may represent an opportunity to prevent weight gain, obesity, and obesity-related chronic illnesses.
Abstract 2:

1. **Motivation**: Benzene is one of the most remarkable molecules in chemistry due to its relative stability compared to other alkenes with three double bonds.

2. **Problem Statement**: The fact that benzene constitutes the basis of aromatic compounds suggests that by understanding the structure of benzene, I will be able to not only study the chemical reactions of this molecule, but also the chemistry involved with aromaticity.

3. **Approach**: After searching the literature,

4. **Results**: I found that the unusual stability of benzene is explained through a molecular orbital description, which shows that its six $p$ electrons occupy three low-energy bonding molecular orbitals and are delocalized over the entire conjugated system.

5. **Conclusions**: Thus, the study of the special structural configuration of benzene can be used to better understand the unique reactions that aromatic compounds undergo.

Abstract 3:

1. **Motivation**: Obesity has increased dramatically over the past two decades and currently about 50% of US adults and 25% of US children are overweight.

2. **Problem Statement**: The current epidemic of obesity is caused largely by an environment that promotes excessive food intake and discourages physical activity.

3. **Approach**: This chapter reviews what is known about environmental influences on physical activity and eating behaviors.

4. **Results**: Recent trends in food supply, eating out, physical activity, and inactivity are reviewed, as are the effects of advertising, promotion, and pricing on eating and physical activity.

5. **Conclusions**: Public health interventions, opportunities, and potential strategies to combat the obesity epidemic by promoting an environment that supports healthy eating and physical activity are discussed.

Abstract 4:

1. **Motivation**: Preeclampsia remains a frequent and potentially dangerous complication of pregnancy. The cause remains largely unknown, but oxidative stress and a generalized inflammatory state are features of the maternal syndrome.

2. **Problem Statement**: The placenta appears to be the principal source of free radical synthesis but maternal leukocytes and the maternal endothelium are also likely contributors.

3. **Approach**: Recent reports have suggested an important role for placental trophoblast NAD(P)H oxidase in free radical generation in preeclampsia.

4. **Results**: The antioxidant vitamin E is now known to have multiple actions in addition to prevention of lipid peroxidation (ie, inhibition of NAD(P)H oxidase activation and the inflammatory response). In view of the abnormally low plasma vitamin C concentrations in preeclampsia, a combination of vitamins C and E is a promising prophylactic strategy for prevention of preeclampsia.

5. **Conclusions**: Several multicenter randomized clinical trials are now underway. The potential use of antioxidants and the recognized, albeit modest, benefit of low-dose aspirin prophylaxis have heightened the need for a reliable predictive test for preeclampsia. A combination test involving several relevant biomarkers is likely to provide the best predictive potential.